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1 IDA 法による MRM-EPI 測定 
 

この章で学べること 

Analyst® software の IDA 機能について解説します。 

IDA 法による MRM-EPI 測定とは、サーベイスキャン(MRM)を行い、リアルタイムで

取得した MRM のシグナルから最も強度の強いイオンを選択し、EPI(MS/MS 測定)を

取得する測定方法です。 

 

MRM 測定で検出されたピークについて MS/MS スペクトルを取得することにより、

MRM 測定で検出されたピークが目的物質であるかどうかを、MS/MS スペクトルのフ

ラグメントのパターンを比較することにより、確認することができます。 

MRM のみでも化合物の同定はできますが、さらに MS/MS スペクトルを取得するこ

とによって、MRM による同定結果の信頼性を高めることができます。 

この高度な同定の確認を行うと、MRM のみの分析によって生じるおそれがある偽陽性ま

たは偽陰性の検出結果を極力減らすことができます。 

※ 偽陽性 - 本当は陰性であるのに検査結果は誤って陽性と出ること 

※ 偽陰性 - 本当は陽性であるのに検査結果は誤って陰性と出ること。 

 

 1-1 EPI（Enhanced Product Ion）モード  

 1-2 IDA（Information Dependent Acquisition）  

 1-3 MRM-EPI Method 作成方法  

 1-4 MRM-EPI により測定したデータの解析  
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＜補足＞ Linear Ion Trap(LIT)モードと四重極モードのスキャンの種類 

Scan Type Q3 のスキャンモード 

Enhanced MS (EMS) LIT 

  Enhanced Resolution (ER) LIT 

  Enhanced Product Ion (EPI) LIT 

  MS/MS/MS（MS3） LIT 

  Enhanced Multiple Charged (EMC) LIT 

  Time Delayed Fragmentation (TDF) LIT 

  Single MS scan modes: Q1/Q3 MS 四重極 

  Precursor Ion (Prec) 四重極 

  Product Ion (PI) 四重極 

  Neutral Loss (NL) 四重極 

  Multiple Reaction Monitoring (MRM) 四重極 

 QTRAP® システムシリーズは、Q3 に四重極と LIT を搭載しています。四重極と LIT

は任意の時間で切り替えて使用することができます(Acquisition Method で設定します)。 

 定量をメインに使用する場合、LIT モードで使用するスキャンは EPI のみになります。 

 EPI 以外の LIT スキャンモードの説明や具体的な操作方法に関しては、本トレーニング

には含まれておりません。 

 下記の資料をご覧いただき、ご不明な点、ご質問などございましたら、アプリケ

ーションサポート宛までご連絡ください。 

 もしくは定性トレーニング(弊社内で実施)も開催しておりますので、そちらのご参

加をご検討ください。詳細はホームページをご覧ください。 

※ LIT スキャンモードの説明については、QTRAP®システムシリーズ定性用説明資料（QT-4N 

QTRAP 定性分析用説明資料_リーガル済 20160324_newLogo.pdf）をご参照ください。 

※ 具体的な使用方法については、QTRAP® Systemシリーズ定性分析用マニュアル（QT-102 QTRAP

シリーズ ver1.5.2_1.6_定性_リーガル済み_20160101_newLogo.pdf）をご参照ください。 

  



 

 5 

1.1 EPI（Enhanced Product Ion）モード 

 

 

 

QTRAP® システムシリーズのスキャンタイプには Trap 機能を用いる Enhanced mode が

あります。 

EPI（Enhanced Product Ion）はこのスキャンタイプのひとつで、MS/MS フラグメントイ

オンを感度良く測定することが可能です。Q2 でフラグメンテーションされたイオンは Q3

にある時間溜められた後に検出器に吐き出されます。また、Q3 でスキャンしている間に

Q0 でイオンを溜め（Q0 Trapping）、より感度を上げることも出来ます。Trap モードの設

定は、メソッドの Advanced MS タブの中で行います。 

Q3(Liner Ion trap)にイオンを溜める方法を選択します。2 つの方法があります。 

① Fixed LIT fill time でイオンを溜める時間を指定する 

*  通常 Q0 Trapping を使用します。 

② Dynamic fill time(DFT)をチェックする 

*  DFT とはサーベイスキャンのイオン量に応じて溜める時間を自動計算させる方法です。

（Advanced MS タブの中にはイオン量の設定はありません。ユーザーで変更する必要もあり

ません）。最適値がわからない場合には Dynamic fill time を使用します。 

PI(四重極)スキャンモードと EPI(LIT)スキャンモードの違い 

EPI スキャンモードはイオンをトラップすることが出来るので、PI スキャンモードよりも感度が良く、質

の高いスペクトルを取得することが可能です。 

PI スキャンモードの場合 

※ RF1 ＜ RF2 ＜ RF3 

Q3 は四重極モードとして機能します。 

A+のイオンを検出するとき、四重極には A+のイオ

ンを通過させるための電圧 RF1 が設定されます。

A+のイオンは四重極を通過し、検出器へ導入され

ます。A+を検出している時間は他の m/z のイオン B+ や C+は電圧が適切でないため、四重極の外へ排出

されます。 

イオン Q3 の設定電圧 

A+  m/z 100 RF1 

B+  m/z 200 RF2 

C+  m/z 300 RF3 

Resolving Fragmentation Trap & Scan Q0 Trapping 
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次に B+のイオンを取り込むため、四重極には B+のイオンを通過させるための電圧 RF2 が設定されます。

B+のイオンは四重極を通過し、検出器へ導入されます。B+を検出している時間は他の m/z のイオン A+ や

C+は電圧が適切でないため、四重極の外へ排出されます。 

EPI スキャンモードの場合 

※ RF1x ＜ RF 2x ＜ RF3x 

Q3 は Linear Ion Trap(LIT)モードとして機能しま

す。A+、B+、C+ のイオンの全てが、Q3(LIT)に

溜められます。 

A+のイオンを検出するとき、LIT には A+のイオン

を検出器へ吐き出すための電圧 RF1x が設定され、

A+のイオンは検出器へ導入されます。A+を検出している時間は、他の m/z のイオン B+ や C+ は Q3(LIT)

に溜められたままです。 

次に B+のイオンを検出器へ吐き出すための電圧 RF2x が設定され、B+のイオンは検出器へ導入されます。

B+ を検出している時間は他の m/z のイオン C+ は Q3(LIT)に溜められたままです。 

また、Q3 でスキャンしている間に Q0 でイオンを溜め（Q0 Trapping）、より感度を上げることも出来ま

す。 

 

 

 

 

イオン Q3 の設定電圧 

A+  m/z 100 RF1x 

B+  m/z 200 RF2x 

C+  m/z 300 RF3x 

Q3(四重極) Q3（Liner Ion Trap)

PIスキャンモード EPIスキャンモード

○は検出器に到達せず、データとし
て取り込まれないイオン 

全てのイオンがトラップ、検出器に到達
し、データとして取り込まれる 
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1.2 IDA（Information Dependent Acquisition） 

IDA とは、サーベイスキャンを行い、リアルタイムで取得した MS スペクトルから強度の

強いイオンを選択し、プロダクトイオンスキャン(MS/MS)のデータを取得する測定方法で

す。ここではサーベイスキャンに MRM、プロダクトイオンスキャンに EPI のモードを使

用します。 

* MRM の他に、サーベイスキャンには、Q3scan、EMS、Prec、NL を利用することもできます。 

MRM-EPI のメソッドは、①既存の MRM メソッドにプレカーサーイオンの選択条件（IDA 

criteria）と EPI を追加して作成する方法と、②IDA Method Wizard を用いて作成する 2

つの方法があります。このマニュアルでは①のみ記載してあります。 

* 既存の MRM メソッドは、この

トレーニングで作成したものを使用しま

す。 

作成したメソッドを使用して標準品

の測定を行い、得られた MS/MS ス

ペクトルを次項「ライブラリーへの

登録および検索」を参照し、ライブ

ラリーに登録します。 

次に作成したメソッドを使用して実

サンプルの測定を行い、得られた

MS/MS スペクトルを次項「データ

ベースの検索」を参照し、検索を行

います。 

また、標準品と実サンプルで観測されたフラグメントパターンを比較することにより目的 

物の確認ができます。 

* フラグメントパターンとは、フラグメントイオンの m/z 値とそれらの強度比のことです。 

 

 

 

 

Survey Scan 

IDA Criteria
プレカーサーイオンの抽出条件

SurveyScan：
MRM 、 EMS 、 Precursor Ion 
scan、Neutral loss scan等

Dependent Scan (MSMS)
Dependent Scan (MSMS)

Dependent Scan (MSMS)

Dependent Scan：
EPI、PI（MSMS）

既存のMRMメソッド

追加

Add to
Exclusion List

Survey Scan 

IDA Criteria
プレカーサーイオンの抽出条件

SurveyScan：
MRM 、 EMS 、 Precursor Ion 
scan、Neutral loss scan等

Dependent Scan (MSMS)
Dependent Scan (MSMS)

Dependent Scan (MSMS)

Dependent Scan：
EPI、PI（MSMS）

Dependent Scan (MSMS)

Dependent Scan：
EPI、PI（MSMS）

既存のMRMメソッド

追加

Add to
Exclusion List

Add to
Exclusion List
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1.3 MRM-EPI Method 作成方法 

 

1. 既存の MRM のメソッドを開きます。 

* 今回のトレーニングで作成した Acquisition Method、LC-MRM.dam を開きます 

 

2. Acquisition Method をクリックし Synchronization Mode に LC Sync を選択します。 

 

3. Acquisition Method で experiment

（MRM）を右クリックし Add IDA 

Criteria Level を選択します。 

* MRM がサーベイスキャンがとなりま

す。(Experiment1) 

 

 

 

 

 

 

ここで IDA Criteria の設定を行います。 
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(1) Select “ 1 ”to“ 1”most intense peaks とします。 

* これにより 1 番目に強いイオンを自動的に選択し、3 つの異なる CE で EPI を測定することがで

きます。 

(2) Which exceeds には、イオンを選択する最低強度を入力します。ここでは 500 を入力します。 

* 500cps を超えた場合にのみ、EPI を取得できます。 

(3) Rolling Collision Energy のチェックをはずします 

* Rolling Collision Energy はペプチド分析に有効な機能です。Intercept と m/z 値と価数に応じて

CE が自動的に設定できます。ここでは使用しません。 

(4) Exclude former target ions の設定を行います 

・Always：1 度だけ EPI 測定をし、その後同じ m/z のイオンは EPI 測定をしない。 

・Never：同じ m/z でも何度も EPI 測定を行う。 

For 10(sec)、After 1 repeat occurrences ：同じ m/z のプレカーサーイオンについて１回 EPI 測定し

たら、その後 10 秒間は同じ m/z のイオンを選択しない。） 

IDA 法による MRM-EPI 測定の推奨値は 2 つあります 

・ Never ： MRM 測定の結果、検出された各化合物のピークの Retention Time(保持時間)が重なってい

ない場合 

・ For 10 (sec)、After 1 repeat occurrences ：MRM 測定の結果、検出された各化合物のピークの

Retention Time(保持時間)が近接している（または重なる）場合。For と After にチェックを入れ、

設定します。時間や回数の設定は目的物質の溶出時間や IDA Method の Cycle time で判断します。 
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* 推奨値は For 10 (sec)、After 1 repeat occurrences になります。 

参考) For は目的物質のピーク幅の半分の値を入力します。推奨値はピーク幅が 20 秒間の場合を想定 

しています。 

(5) After Dynamic Background Subtraction of Survey scan： ベースラインイオンを排除することで 

バックグラウンドに埋もれている、イオンの MS/MS スペクトルが取得できるようになります。 

* チェックを入れます （詳しくは、質量分析 APIQTRAP 定量トレーニング参考資料の「参

考資料 9 Dynamic Background Subtraction (DBS)」を参照ください。 

4. 次に IDA Criteria 上を右クリックして Add experiment を選択し、Experiment を 1 

つ追加します。 

* Experiment2 が追加されます 

 

5. Experiment の Scan Type に EPI を選択し、設定を行います。Start (amu)と Stop(amu)

に測定したい範囲を入力し、Optimize Masses をクリックします。ここでは Start  50、

Stop 315 を入力します。 

* Stop は、MRM トランジションのうち最も大きい Q1 mass + 5 の値を入力します 
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6. 下図のように表示されます。Scan rate を 10000Da/sec、Number of scans to sum を 1

と入力します。 

※Scan rate は装置毎に異なります。下表をご参照ください。 

 

 

 

 

 

 

 

7. 次に Advanced MS タブを選択し、Dynamic fill time を選択します。 

 

 

8. MS タブに戻り、Edit Parameters…ボタンをクリックして、Source/Gas タブの CA 

の値を設定し直します。Experiment1(MRM)と Experiment2(EPI)の両方について行い

ます。 

Experiment1(MRM)の CAD は装置毎に異なります。上記表をご参照ください。 

Experiment2(EPI)の CAD は High または 12（10） 

* CAD 以外のパラメータには、FIA で最適化した値、もしくは Default の値を入力してください。

Experiment1(MRM)と Experiment2(EPI)とも CAD 以外は同じ値を入力します。 

* 農薬の場合、TEM の Default 値は 500℃になります。ただし、熱に弱い化合物を含む場合には、

350℃を推奨します。 

装置 
使用する

ScanRate 

使用する

CAD 

 
QTRAP® LC/MS/MS System 
3200 QTRAP® LC/MS/MS System 
4000 QTRAP® LC/MS/MS System 

4000 10 

AB SCIEX QTRAP® 4500 LC/MS/MS System 
AB SCIEX QTRAP® 5500 LC/MS/MS System 
AB SCIEX QTRAP® 6500 LC/MS/MS System 

10000 12 



 

 12

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Experiment 2 上を右クリックして Copy this experiment を選択し、Experiment3 を追 

加します。さらにもう一度、Copy this 

experiment を選択し、Experiment4 を追加

します。 

10. EPI の Experiment2～4 の MS タブの 

Edit Parameters…ボタンをクリックし、 

Compound タブの DP および CE を入力 

します。 

DP は初期値の 30、もしくは適切な値を 

入力します。 

CE は Experiment 2、3、4 にそれぞれ 

20、35、50 と、異なる値を入力します。 

CES には「0」を入力します。 
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* CES：CES を入力すると Scan time を 3 分割し、3 種類の CE で測定したデータを足し合わせた

形でスペクトルが表示されます。例えば CE に 30 を入力し、CES に 5 を入力すると CE は 30±5

となります。 

11. 各 Experiment の、Source/Gas タブをクリックし、Experiment2～4(EPI)とも全ての

パラメータについて同じ値が入力されていることを確認します。 

* Experiment2～4(EPI)の CAD は High 

* Experiment1(MRM)と Experiment2～4(EPI)は、CAD 以外は同じ値になります。 

 

12. LC ポンプ、オートサンプラー等の設定を行います。 

13. File Menu から Save As を選択し、名称に MRM-EPI を入力して Method を保存しま

す。 

14. LC のラインを MS に接続し、測定を開始します。 

* データの閲覧方法は、この後に記載があります 
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MRM-EPI 測定結果にて、MS/MS スペクトルが取得できなかった場合 

 

MRM クロマトグラムで観測されたピーク約 1000cps が EPI での検出下限値のめやすと

なります。（感度は化合物に依存します。） 

濃度が低いと、質の悪いスペクトルになる、または全くフラグメントイオンが観測されな

い場合もあります。その場合は、手順①を下記の設定にして、再度分析してみてください。 

Advanced MS タブを選択し、Fixedfill time 100(ms)を入力し、Q0Trapping にチェック 

をいれます。 

 

※Fixedfill time の値は装置によって異なります。下記表をご参照ください。 

 

 

 

 

 

 

 

 

 

装置 
Fixed 

LIT Fill 
time 

 
QTRAP® LC/MS/MS System 
3200 QTRAP® LC/MS/MS System 
4000 QTRAP® LC/MS/MS System 
AB SCIEX QTRAP® 4500 LC/MS/MS System 

250 

 
AB SCIEX QTRAP® 5500 LC/MS/MS System 
AB SCIEX QTRAP® 6500 LC/MS/MS System 

100 



 

 15

MRM-EPI 多成分一斉分析の推奨設定 

 

サーベイスキャン(MRM)でモニターする成分数が多い場合、Experiment1 （MRM）につ

いて、下記の設定をされることをお勧めします。 

※いずれの設定も、Cycle time を減らすために行っています 

・ 各 MRM トランジションの dwell time(msec)を合計して、約 500ｍsec になるように

dwell time(msec)を設定します。 

・ dwell time(msec)は、QTRAP®, 3200QTRAP®, 4000QTRAP®では、1 成分あたり

5msec 以上で、QTRAP®4500, QTRAP®5500, QTRAP®6500 では、1 成分あたり 2msec

以上でお使いください。 

* 10 成分の場合は、500msec/10 = 50 msec 

* 100 成分の場合は、500msec/100 = 5msec 

* 下記の例) 80 成分の場合、500msec/80 = 6.5msec ≒ 5msec 

・ 40 成分を超えるような場合は、Advanced MS タブをクリックします。 

Pause time(pause between mass range) を 5msec から 2msec に変更します。 
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Cycle time、Pause time、Dwell Time とは 

 

Dwell Time とは 1 成分を測定する時間(msec) 

Pause time とは 

pause between mass range のこと。 

1 成分を測定した後、Q2（コリジョンセル）に残っ

たイオンを排出し、次の成分を測定する条件に電圧

を切り替える時間(msec)。 

Default 値は 5msec。 
1 成分について 1 ポイント測

定 す る の に 要 す る 時 間 
(msec) 

= Dwell Time + Pause time 

Cycle time とは 

MRM-EPI の場合 

1 Cycle Time  =   

MRM （ msec ） + EPI(msec) + EPI(msec) + 
EPI(msec) 
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1.4 MRM-EPI により測定したデータの解析 

1. IDA Explore の表示 

Menu Bar の Tools/Setting/Appearance Options を選択します。IDA Explore のタブを

クリックし、Use IDA Explore to Display IDA Samples にチェックをすると IDA 

Explore の形式で表

示されます。 

2.  Explore の形式で

画面が表示される

ことを確認してく

ださい。 

※ トレーニングでは先ほど取得した IDA のデータ（MRM-EPI.wiff）を使用します 

3. データの確認 

Window 左側の Mass List View で、イオン（m/z）をクリックして選択してください。 

Window 右側に、選択したイオンのクロマトグラム、スペクトルが表示されます。 

IDA Explore で表示した画面 

・ Mss List View の Time(min)、

m/z、Intensity のタイトルを

クリックすると、昇順・降順

で並べ替えることができます。 

4. クロマトグラムの表示 

より詳細なデータを確認するために、TIC 上での操作を行います。 

TIC を画面に表示するには、Tool Bar の Show TIC icon をクリックします。 

 

 

 

5. TIC の画面が開きます。ピーク上（2.9 分）をダブルクリックすると、その時間の MRM

スペクトルと 3 つの EPI MS/MS スペクトル（m/z 265）が表示されます。 
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※ 上から順番に MRM、EPI(CE20)、EPI(CE35)、EPI(CE50)と並びます 

 

 

 

 

 

 

 

 

 

6. その他のピークの確認 

TIC の 2.9 分付近のピーク上の点線をドラッグして別のピーク（3.7 分）へと移動させ

ます。移動後の 3.7 分の MRM スペクトルと 3 つの EPI MS./MS スペクトル（m/z 311）

が表示されます。 

※ 表示させた MS/MS スペクトルのライブラリー登録方法につきましては、「2.ライブラリー

への登録および検索」をご参照ください。 
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2 ライブラリーへの登録および検索 
 

 

 

この章で学べること 

Analyst® software のライブラリー機能について解説します。 

ライブラリーとは、MS/MS スペクトルデータベースのことです。化合物情報

や MS/MS スペクトルの登録、追加、編集、検索を行うことができます。 

 

MRM で検出、同定された化合物について、前章の方法で EPI MS/MS スペク

トルを取得し、ライブラリー検索を行うことによって、MRM の同定結果の

信頼性を高めることができます。 

 

 2-1 ライブラリーデータベースの選択方法 

 2-2 ライブラリーの登録  

 2-3 ライブラリーへの追加と編集 

 2-4 ライブラリーの検索  

 2-5 新規にライブラリーデータベースを作成する方法  
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2.1 ライブラリーデータベースの選択方法 

 

使用するデータベースを選択して使い分けることにより、目的のデータベースを構築、検

索することができます。 

例えば、農薬のデータベース、ドラッグのデータベースと複数のファイ

ル(*.mdb)が存在する場合、ライブラリーに利用するデータベースを切

り替えて使用できます。 

※ 注意！) 2 つのデータベースを作成した後、1 つに合併させることはできません。 

 

操作方法 

Training.mdb を使用して、操作を行ってください。 

1. Analyst®ソフトウエアの Explorer モードにて、  Tools メニュー  ＞Settings＞

Optimization Options… を選択し、右の画面を表示させます。 

 

 

 

2. Library Manager タブの Browse ボタンで、使用するデータベースを選択します。 

3. Connection を押して、Connection Successful のメッセージが出ることを確認します。 

4. OK をクリックします。 
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2.2 ライブラリーへの登録 

※ Training では Project：Example、LIT フォルダ中の Reserpine の EPI データを使用

します。 

1. Explore の Open Data File をダブルクリックし、EPI で取得したデータを開きます。

クロマトグラムを左ドラッグでピークを選択し、続いて選択部分をダブルクリックし

て MS/MS スペクトルを表示します。 

* 青三角印を上下させ、ノイズの m/z をラベルし

ないようにします。この矢印より上、つまりラ

ベルされたm/z情報がライブラリーに登録され

ます。 

 

2. 画面上を右クリックし、Add a Record を選択します。（または Tool Bar の

Explore/Library Search/Add…を選択します。） 

3. 以下のウィンドウが開きますので、Mass Spectral Information タブにて、Compound 

Name、Formula、CAS Number などを入力します。 

* Mass Spectrum と Molecular Weight、m/z、Intensity、Mass Spec Data 等は自動で入力

されます。 

* Formula を入力すると、精密質量が計算され、Molecular Weight に表示されます。 

*  

 

 

 

 

 

 

 

 

 

スペクトルの m/z の情報と共に、分析した際の条件

が自動的に反映されます。 
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m/z、 Intensity、Mass 

Spec Data等は自動的

に入力されます。 

4. General Information タブにて、Mol File で作成した構造式や UV スペクトル等の情報

を登録します。  構造式を登録する場合は、Open Molecular Structure File Name

の Browse…をクリックします。ファイルを選択して Open をクリックすると構造式が

Import されます。 

* 構造式は ISIS Draw もしくは Chem Draw などの市販のソフトウエアを用いて作成し、あ

らかじめ.mol の形式で保存します。 

* Analyst®ソフトウエアは.mol の形式で保存された構造式のみ読み込み可能です。 

必要に応じて Other Information に情報を入力します。 

5. OK をクリックすると、登録は完了です。 

 

2.3 ライブラリーへの追加と編集 

既に登録されている化合物に対し、スペクトルの追加や登録情報の変更ができます。 

1. Explorer モードで、追加したい MS/MS スペクトルを表示します。 

＊ 青三角印を上下させ、ノイズの m/z をラベルしないように 

します。 

この青三角印より上、つまりラベルされた m/z 情報がライブラ

リーに登録されます。 

 

 

 

 

 

2. Tool Bar の Explore/Library Search/List を選択します。 

スペクトルを追加する 

3. 下図のデータベースが開きますので、追加する化合物の行を選択し、Append MS をク

リックします。 
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4. 登録情報を確認し、OK をクリックします。 

登録情報を変更する 

5. 変更する化合物の行を選択し、Edit をクリックします。続いて登録情報を変更します。 

 

2.4 ライブラリーの検索 

1. Explorer モードで、検索したい MS/MS スペクトルを表示します。 

※ トレーニングでは、Reserpine の EPI MS/MS スペクトルを使用します。 

※ 青三角印を上下させ、ノイズの m/z をラベルしないようにします。この矢印より上、つま

りラベルされた m/z 情報でライブラリーを検索します。 

2. 画面上で右クリックし、Search Library を選択します。（または Tool Bar の

Explore/Library Search を選択します。） 

3. 検索結果が表示されます。 

4. 一番上の段は Unknown’s MS （測定した MS/MS

スペクトル）、2 番目の段は検索結果で 1 番目に Hit

した化合物のライブラリースペクトルです。 

5. また View Manager をクリックし Show UVs にチ

ェックをすると UV のクロマトグラムが表示され

ます。 

※ UV のデータが登録されている場合にのみ表示されます。 

※ Fit：Unknown スペクトルに対して、ライブラリーのスペクトルが何％一致しているか 

※ Revfit：ライブラリーのスペクトルに対して、Unknown スペクトルが何％一致しているか 

※ Purity：Fit、Revfit の結果を総合的に評価した一致率 
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検索条件を指定する 

※ フラグメントイオンの m/z だけでなく、登録情報の項目を指定して検索ができます。 

検索するデータを絞り込むことができるため、検索の精度が向上します。 

推奨は、CE および 1st Precursor m/z の検索条件を指定することです。 

トレーニングでは、Reserpine の EPI MS/MS スペクトルを使用します。 

※ CE=45、1st Precursor は m/z 609.2 です。 

6. MS/MS スペクトル上を右クリックし、Search with Constrains…を選択します。 

 

 

 

 

 

CE の検索条件設定 

7. Collision Energy にチェックを入れ、+/-に 0 を

入力します。 

※ 測定データの CE の値は自動で認識されます。 

※ Reserpine の EPI MS/MS スペクトルは、Collision 

Energy (CE) =45 で測定を行ったので、CE=45 で登

録されたデータのみ検索を行います 

1st Precursor m/z の検索条件設定 

8. 1st Precursor m/z にチェックを入れ、+/-に 1 を

入力します。 

※ 測定データの Precursor m/z の値は自動で認識され

ます。 

※ Reserpine の Precursor ion は m/z 609.2 なので、

Precursor ion が m/z 608.95～609.45 で登録された

データのみ検索を行います 

9. Search をクリックします。 
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2.5 新規にライブラリーデータベースを作成する方法 

Analyst から新規にライブラリーデータベースを作成することはできません。既存の

Compoundlib.mdb を複製後、名前を変更して利用します。 

1. Windows の Explore で、X:¥AnalystData フォルダを開きま

す。 

2. compoundlib.mdb ファイルをコピー&ペーストします。 

* compoundlib.mdb 上を右クリック＞ ポップアップメニューから

Copy を選択し、続いてフォルダ中の空欄部分を右クリック＞ ポップアップメニューから paste

を選択します。 

3. copy ～compoundlib.mdb が作成されますので、名前を変更してください。 

* copy ～compoundlib.mdb 上を右クリック＞ ポップアップメニューから Rename を選択します。

（例：Training.mdb と命名） 

4. Training.mdb には、前者で使用した Compoundlib.mdb のデータが含まれていますの

で、適宜データを削除して使用してください。 

* データの削除方法につきましては、 Tool Bar の

Explore/Library Search/List を選択し、左記ウィンドウの

Delete ボタンで実行できます 

この操作により、名称は異なりますが内容がまったく同じ

データベースが 2 つ存在することになります。この時点で

は Analyst®ソフトウエアは compoundlib.mdb を認識しています。今回、新規作成した

Training.mdb を使用する場合は、21 ページ「2.1 ライブラリーデータベースの選択方法」

をご参照ください。 

 

以上で、MRMーEPI 測定～ライブラリートレーニングは終了です。 
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3 MRM3 を用いた定量 
 

 

 

この章で学べること 

Analyst® software の MRM3 機能について解説します。 

MRM3 とは、LIT (Linear Ion Trap)スキャンモードの一つ、MS/MS/MS を用

いた定量分析法です。 

検出された 2nd Product Ion のスキャンデータからマスクロマトグラムを作

成することにより、MRM モードよりも高い選択性を示すことができます。 

MRM モードの測定において複雑なマトリックスや溶媒由来の影響でバック

グラウンドが高くなる場合に、選択性の高い MRM3 による定量は非常に有効

な手段です。 

※ QTRAP4500、5500、6500LC/MS/MS システムに有効な測定モードです。 

 

 3-1 MS/MS/MS（MS3）を用いた定量について 

 3-2 MRM3 Optimization Script を用いた自動最適化  

 3-3 マニュアルでの最適化 

 3-4 イオンソースの最適化 

 3-5 Acquisition Method の作成 

 3-6 Explore モードでのデータ確認方法 

 3-7 MS/MS/MS の定量解析 
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3.1 MS/MS/MS（MS3）を用いた定量について 

 

3.1.1 MS/MS/MS とは 
LIT(Linear Ion Trap)スキャンモードの一つです。 

Q1: Precursor Ionの選択 → q2 Collision Cell: Fragmentation → Q3 (LITのモード): 2nd 

Precursor Ion の選択 → Fragmentation→ Scan になります。 

MS/MS/MS (MS3)は、q2 で生成したフラグメントイオンのうち、特定のフラグメントイ

オンをイオントラップ内で単離し、さらにフラグメンテーションするスキャンモードです。 

 

 

 

 

Q1 で 1st Precursor Ion が選択されます。 

1st Precursor Ion は、q2(Qurve® LINAC® Collision Cell)でフラグメンテーション

を受け、1st Product Ion を生成します。 

1st Product Ion は、Q3(Linear Accelerator™Ion Trap)に導入され、トラップされま

す。 

 

 

 

 

Q3 でトラップされた 1st Product Ion から、2nd Precursor Ion が分離されます。 

 2nd Precursor Ion は、Q3 において単一周波数で励起され、フラグメンテーション

を受け、2nd Product Ion が生成されます。 

 生成された 2nd Product IonがQ3でトラップされた後、スキャンされ検出されます。 
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3.1.2 MRM3 による定量とは 

 

MS/MS/MS(MS3)スキャンを使用し、検出された 2nd Product Ion のスキャンデータから

マスクロマトグラムを作成することにより、MRM モードよりも高い選択性を示すことがで

きます。 

MRM モードの測定において複雑なマトリックスや溶媒由来の影響でバックグラウンドが

高くなる場合に、選択性の高い MRM3 による定量は非常に有効な手段です。 

バックグラウンドが低い場合には、MRM モードでの測定が有効です。 

 

＜りんご中の Malathion を MRM モード及び MRM3 で測定した、クロマトグラムです＞ 

 

 

 

 

 

 

 

MRM3 の選択性の高さがわかります。 
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3.1.3 MRM3 測定の流れ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

１．最適化 

１）インフュージョンによる、MS3 の最適化を実施  

＜MRM3 Optimization（自動最適化プログラム）を Run する前の準備＞ 

１）-１．シリンジポンプによる分子関連イオンピークの確認 

１）-２．Starter Acquisition Method の作成 

＜MS3 Quant Optimization（自動最適化プログラム）の Running＞ 

１）-３．MS3 Quant Optimization の条件設定 

自動最適化により、MRM3 メソッドが自動作成されます 

２）MS/MS/MS(MS3) のパラメータ AF2 値をマニュアルで最適化 

MRM3Optimization Script で作成した MRM3 メソッドでは、マトリックスの影響を軽減でき

ない場合 又は、更なる感度を追求されたい場合は、AF2 パラメータをマニュアルで最適化し

ます。 

MRM3 の自動最適化の結果 Log を参考に、Intensity の高い複数 2nd Precursor Ion から複数

の 2nd Product Ion と各最適な AF2 値を探します。 

２．MRM3 メソッド（Acquisition Method）の作成 

複数 Experiment で、複数の 2nd Precursor Ion を組んで、マトリックス入りサンプルを測定

します。  

４．MRM3 の定量解析 

３．Explore でのスペクトルとマスクロマトグラムの確認 

MRM3 メソッドで測定したデータのスペクトルより、マスクロマトグラムを作成し、 

定量するピークの幅を確認します。 
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3.2 MRM3 Optimization Script を用いた自動最適化 
＊ Training ではレセルピン及びブロモクリプチン標準溶液を用いて、最適化～定量までを説

明します。他の成分でも同様の手順にて測定を行うことが出来ます。 

3.2.1 MRM3 Optimization Script のインストール 

Analyst® Software のインストール時にインストールされます。 

 

3.2.2 MRM3 Optimization Script のメソッド作成工程 
MRM3 メソッドは以下の順に種々のスキャンモードを用いて、自動最適化を行ないます。 

1. 1st Precursor Ion の測定  

Enhanced Resolution (ER)スキャンを使用します。 

＊ ER は分解能を上げ、イオンの価数またはアイソトープパターンの確認を行うスキャンモ

ードです。詳細は定性マニュアル「QTRAP システムシリーズ定性用説明資料」を参照下

さい。 

2. DP および EP 電圧の最適化   

Q1 Multiple Ion (SIM)スキャンを使用します。 

3. 2nd Precursor Ion の測定と 定量メソッドに用いる 2nd Precursor Ion の選択  

Enhanced Product Ion (EPI)スキャン CE = 45V±20V を使用します。 

4. CE 電圧の最適化  

Multiple Reaction Monitoring (MRM)を使用します。 

5. 2nd Product Ion の測定と定量メソッドに用いる 2nd Product Ion の選択と AF2 電圧

の最適化  

MS/MS/MS（MS3）スキャンを使用します。 

AF2 の値は、電圧を上げていき、2nd Precursor Ion が 5% 残存する電圧を採用

します。 

＊ AF2 は LIT 内で 2nd Precursor Ion を壊すエネルギーです。(QT5500 の場合、0v から 0.3v

を 0.015v 刻みで Ramp していきます) 

決定した AF2 電圧を用いて MS3 スキャンを測定し、生成した 2nd Product Ion
のうち、強度の強い 2 個を選択します。 
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ただし、2nd Precursor Ion のカウント数が、総カウント数（2nd Precursor Ion のカウント数 

+ 生成した 2nd Product Ion のカウント総数）の 10%以上であった場合、”フラグメントイオ

ンなし（no fragments）”として判断され、メソッドは作成されません。 

 

6. 定量用 MRM3 メソッドの自動作成 

最適化した結果、最も強い Intensity が観察された 2nd Product Ion を定量用

MRM3 メソッドとして採用します。 

 

3.2.3 MRM3 Optimization（自動最適化プログラム）を Run する前の準備-1 
シリンジポンプを用いて 5～10μL/min 流速で標準溶液を連続注入し、Q1 スキャンで

分子関連イオンを確認します。 

1. 標準溶液を調製します。 

QTRAP® 5500、6500 LC/MS/MS System では 100ng/mL 程度、QTRAP® 4500 

LC/MS/MS System では 500ng/mL 程度を用意します。ただし、測定対象の感度に応

じて、濃度を調製する必要があります。 

2. 標準溶液をシリンジに詰め、シリンジポンプにセットします。 

3. ターボイオンスプレーが装着されていることを確認します。 

イオンソースのタイプは Analyst®software 画面の右下マスのアイコンをダブ 

ルクリックすると表示されます。 

4. シリンジとイオンソースを接続します。 

5. Tune モードの Manual Tuning をダブルクリックします（画面が開きます）。 

 

 

 

 

 

 



 

 32

6. 左側は初期値のままとし、右側の Scan type が Q1MS(Q1)になっていることを 

確認します。 

7. Scan rate を選択します。 

＊ Scan rate は、10、200、1000、2000Da/s を選択できます。 

＊ Training では、1000Da/s を選択します。 

8. Positive モードあるいは Negative モードを選択します。 

＊ Training では、Positive を選択します。 

9. Scan type の右側の Start および Stop に測定したい範囲を入力します。 

通常、目的化合物の分子量の 10Da 程度小さい値から、50Da 程度大きい値(アダクト

を確認するため)を入力します。複数の化合物を同時に最適化する場合、すべての化合

物が観測される範囲に設定します。Time はこの Scan の 1 サイクルあたりの時間（秒）

で、自動で入力されます。 

＊ レセルピンの場合は、Start-Stop に 550 から 650 までを入力します。 

＊ ブロモクリプチンの場合、Start-Stop には 600 から 700 までを入力します。 

10. 画面中央下部の Duration に測定時間を入力します。 

＊ シリンジでの連続注入が安定しているかどうかを確認するために、5～10 分程度を入力します。 

11. 左上の Start をクリックし、測定を開始します。 

＊ Acquire…ボタンをクリックして測定を開始しない場合は、測定データは保存されません。 

12. シリンジポンプをスタートします。流速は、5～10μL/min 程度とします。 

＊ 最初、チューブの中にエアが入っていると、スペクトルが不安定になることがあります。 

＊ しばらく経つと安定します。急いでいる場合は、少し手で押すか、流速を最初のうちだけ上げ

て測定します。 
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＜シリンジポンプのスタート方法＞ 

QTRAP® 5500 LC/MS/MS System はシリンジポンプが内蔵されていますので、

Manual Tuning 画面から制御できます。 

 

(1) Syringe Pump Methodを選択し、Syringe Diameterにシリンジの内径を、Flow 

rate に流速を入力後、Start Syringe Pump ボタンをクリックします。 

＊ ボタンは Stop Syringe Pump に変わります。 

(2)  測定途中で流速を変更したいときは、Flow rate に流速を入力後、Set Flow rate

ボタンをクリックします。 

(3) シリンジポンプを止めたいときは、Stop Syringe Pump ボタンをクリックしま

す。 

13. 以下の 4 項目をチェックしてください。自動最適化を実行するにあたり、以下の条件

を満たしておく必要があります。 

＊ 左下のクロマトグラム画面にて TIC が安定していること 

＊ Positive、Negative のどちらでイオン化するか確認すること 

レセルピン及びブロモクリプチンの場合、Positive モードの方がよりイオン強度が強くなり

ます。 

＊ 目的化合物の分子関連イオンが観測されていること(m/z 609 及び m/z 654) 

＊ 分子関連イオンの強度が低くても、高くてもソフトは止まりません。 

＊ 少し濃い 1x107～1x108cps 濃度を使うと夾雑と間違える可能性が低くなります。 

14. 確認した後、左上の Stop をクリックし測定を止め、Manual tuning 画面を閉じます。         

画面を閉じる前に保存するかどうかの警告がでますので、No で閉じます。 

このときシリンジポンプは動いたままにしておいてください。 
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3.2.4 MRM3 Optimization（自動最適化プログラム）を Run する前の準備-2 
全自動MS/MS/MSメソッドを作成するためのStarter Acquisition Methodを作成しま

す。このメソッドにて分子イオンの m/z を自動的に確認し、その後、その分子のフラ

グメントイオンの評価を行ないます。 

 

1. Analyst®software の Acquire モードから、Build Acquisition Method をダブルクリッ

クします。 

2. 次の図のような仮の Method を作成します。 

Scan Type は Enhanced Resolution(ER)を選択し、Center には適当な数字を入力しま

す。Scan rate は、250Da/s のままにしてください。この段階ではイオン源パラメータは、

TEM が「0」の Default 値のままにします。 

 

 

 

 

 

 

 

 

 

3. Syringe Pomp の Diameter を 4.61、Flow rate を 5～10ul/min に設定します。 

4. Method の名前をつけて Save します。 

＊ トレーニングでは Starter method. dam という名前で保存します。 
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3.2.5 MRM3 Optimization（自動最適化プログラム）の Running 
MRM3 Optimization の条件設定を行います。 

 

1. メニューバーの Script ＞ MRM3 Optimization を選択します。 

右記のような画面が表示されます。 

＊ この画面はメイン画面の Setting ボ

タンをクリックすることでも表示

できます。 

2. Acquisition MethodのBrowse...ボタン

をクリックし、34 ページで作成した

Starter メソッドを指定します。 

＊ トレーニングでは Starter method. dam を選択します。                         

3. Compound Name に化合物の名前を入力します。 

＊ トレーニングでは Reserpine と入力します。 

4. Q1 Resolution から MS/MS や MRM3 を測定する際の Q1 の分解能を選択します。 

＊ トレーニングでは Unit を選択します。 

5. Expected m/z (amu) に最適化したい MS 値を入力します。 

＊ トレーニングでは 609amu と入力します。 

＊ 分子量などわからない場合は、 Calculate from 

chemical formula ボタンをクリックし、組成式から計

算することができます。 

6. Polarity から標準物質がイオン化する Polarity を選択

します。 

＊ トレーニングでは Positive を選択します。 

7. Setting 画面の Advanced ボタンをクリックします。  

次頁のような画面が表示されます。 
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(1) Enhanced Resolution 

Scan rate： ER スキャンのスキャンスピードを選択します。 

＊ トレーニングでは 10000Da/sec にします 

(2) Q1 Multiple Ion 

DP Ramp： 最適化を行なう DP のレンジを設定します。 

＊ トレーニングでは Start に 0V、Stop に 200V、Step に 5V を入力します。 

(3) Enhanced Product Ion 

Scan rate： EPI スキャンのスキャンスピードを選択します。 

＊ トレーニングでは 10000Da/sec にします。 

2nd Precursors： 生成したフラグメント(2nd Precursors)のうち強度の高い方から何

番目までを候補とするかを設定します。 

＊ トレーニングでは「5」にします。 

Mass rage： 2nd Precursor イオンのスキャン範囲を設定します。 
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(4) MS/MS/MS 

Scan rate： MS/MS/MS スキャンのスキャンスピードを選択します。 

＊ トレーニングでは 10000Da/sec にします。 

Mass rage： 3 rd precursor ( 2nd Precursor) イオンのスキャン範囲を設定します。 

(5) General Final Method 

Save All Final Methods ： 最終的に作成される、定量用の MS/MS/MS メソッドだ

けでなく、最適化途中のメソッドも保存します。 

Save Optimal Method Only ： 最終的に作成される、定量用の MS/MS/MS メソッド

のみを保存します。 

＊ トレーニングでは Save All Final Methods を選択します。 

8. OK ボタンをクリックし、メイン画面に戻ります。 

9. Start ボタンをクリックすると、最適化が開始します。 

.dam の文字をクリックすると

表示されているデータの測定メ

ソッドを見ることができます。 

.wiff の文字をクリックすると

表示されているデータをAnalyst

上で見ることができます。 
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＜MRM3 Optimization（自動最適化プログラム）の結果＞ 

 

1. 最適化された測定メソッド 

最適化中、あるいは、最適化後に作成されたメソッドは、Starter method を保存した

フォルダと同じ Acquisition methods フォルダに保存されます。 

保存されたメソッドは “[化合物名] + [スキャンタイプ] + [m/z] + .dam”. という名前

です。 

＊ トレーニングにて、最適化した結果、得られた定量用の MRM3 メソッド名は、

“ Reserpine2_FinalOptimalMS3_174.076.dam “です。 

※ 作成されたメソッドを用いて、検量線サンプルの測定などを行ないます。 

 

2. 結果の Log ファイル 

Analyst Data＞Projects＞Projects 名＞Data フォルダ内に Result.txt ファイルで保

存されます。 
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Results.txt ：  

 

 

 

 

 

 

 

 

 

 

測定した日時 

最適化前に 

設定した条件 

1st Precursor

最適化の結果 

最適化された 

MS3 フラグメント 
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3.3 マニュアルでの最適化  

 

MRM3 Optimization Script で自動最適化した MRM3 メソッドでは、マトリックスの

影響を軽減できない場合又は、更なる感度を追求されたい場合は、MS/MS/MS のマニ

ュアルでの最適化を行います。 

MRM3 の自動最適化の結果 Log を参考に、Intensity の高い 2nd Precursor Ion を複数

選び、有効な MRM3 メソッドを作成します。 

AF2 値をマニュアルで最適化します。 

 

1. Tune モードの Manual Tuning 画面を開きます。 

2. Open File から自動最適化で作成された “[化合物名] + [スキャンタイプ] + [m/z] 

+ .dam”.を開きます。 

＊ Training では Reserpine2_MS3_RampAF2_397.166.dam を開きます。 

MRM3 の自動最適化では、1st Precursor / 2nd Precursor / 2nd Product = 609 / 174 /159 が選

択されます。 

3. Scan type に、MS/MS/MS(MS3)が選ばれていることを確認します。 

4. Scan rate、Polarity を確認します。 

＊ Scan rate は、1000、10000、20000Da/s が選択できます。 

＊ Positive モードあるいは Negative モードを選択します。 

＊ Training では、Scan rate=10000Da/s 、Positive を選択します。 

5. 1st Precursor Ion, 2nd Precursor Ion に数値が入力されている事を確認します。 

6. Center/Width のチェックを外し、測定する範囲、2nd Precursor Ion が見える範囲ま

でとします。 

7. Optimization Masses を押すと Time(sec)は自動で算出されます。 

＊ その他のパラメータ(DP、EP、CE)は、自動最適化した値が Compound タブに入力されてい

ます。 
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8. Advanced Ms のタブへ移ります。 

9. Fixed LIT fill time にチェックをいれます。溜める時間は、10msec 程度にします。 

＊ Ramp を使用する時は、Dynamic fill time は使用できません。 

 

 

 

 

 

 

10. MS タブに戻ります。 

＊ Number of scans to sum を入力してください。Training では、「3」と入力します。 

＊ Number of scans to sum の表示について、一度 Advanced MS のタブへ移動し、イオンを溜

める時間（Fixed LIT fill time と Dynamic fill time）を切り替えた後に MS タブへ移ります

と、Number of scans to sum 欄の数字が「1」に戻ります。 

11. Edit Ramp を押し、Ramp Parameter Settings の画面を開きます。 

③ 
④ 

⑤ 

⑥ 
⑦ 

⑩ 
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12. Parameter に、Excitation Energy をプルダウンメニューから選びます。 

Stepを0.01に設定し、OKを押します。 

 

 

 

 

 

13. Start ボタンを押し測定を開始します。 

14. TIC の画面全体をマウスで選択しダブルクリックします。平均されたスペクトルが下

段に表示されます。その中で強度の高いマス値を 2nd Product Ion とします。 
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15. 13 で選択した 2nd Product Ion のマス値を選択し右クリックし、Extract Ions (Use 

Maximum)を選択します（下図中の赤点線枠内）。 

＊ 2nd Product Ion は、一つに絞らず、複数候補挙げておき、最適な各 AF2 をメモ

してください。X 軸に AF2 をランプした XIC が下段に出てきます。クロマトグラ

ムの一番強い値が、この 2nd Product Ion に最適な AF2 値となります。 

＊ 感度が低い場合は、Fixed LIT fill time の溜める時間を長くします。 

＊ Q0 トラッピングにチェックをいれることも有効です。 

 

 

16. 内部標準物質も MRM3 で測定する場合は、2～15 と同様に操作し、2nd Product Ion

とそれに最適な AF2 値を最適化します。 

17. メニューの File＞Save as でメソッドを保存します。 

＊ Training では、Reserpine_MRM3_609.397.dam で保存します 

18. 複数の 2nd Precursor Ion について、2～17 の操作を行い、AF2 の値をメモします。 
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3.4 イオンソースの最適化 

 

イオンソースの最適化は、まず以下の値を使用して頂き、感度が足りない場合に、 

必要に応じて行って下さい。 

＊ MRM3 のメソッドでは、自動最適化はできませんので、MRM3 の定量は MRM で最適化し

た値を用います。 

＊  Training では、イオンソースの最適化は行いません。 

以下のパラメータ値を入れて下さい。 

 

イオンソースパラメータ初期値（QTRAP® 5500 LC/MS/MS System） 

 設定範囲 
ESI 

 (5uL/min,Infusion) 

ESI 

(200uL/min,Infusion) 

APCI 

(1000uL/min) 

CAD 0～12 12 12 12 

CUR 10～50 20 30 45 

Gas1 0～90 20 50 60 

Gas2 0～90 0 80 N/A 

IS 0～5500 5500(-4500) 5500(-4500) N/A 

NC 0～5 N/A N/A 2(-2) 

TEM 0～750 0 500 500 

備考） カッコ（）内は Negative モード時の設定値を表します 

＜！注意!＞-------------------------------------------------------------------------------------------------------- 

QTRAP® 5500 LC/MS/MS System 

TISの設定温度は最大700度までにしてください 

750℃でも使用できますが、ヒーターの寿命が短くなりますので推奨しません。 
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3.5 Acquisition Method の作成 

 

使用するマトリックスの影響を一番受けない MRM3 メソッドを作成する為に、複数

Experiment で複数の 2nd Precursor Ion の MRM3 メソッドを作成し、マトリックス入り

サンプルを測定します。 

測定結果より、S/N が一番良好な MRM3 を決定します。 

 

3.5.1 複数 Experiment による MS3 メソッドの作成 
1. Hardware Configuration の Profile を MS+HPLC のものに変更します。 

Acquire モードから、メニューの File>Open を開き、File type を Acquisition Method

とし、40 ページで保存した最適化された MRM3 メソッドを開きます。 

＊ Training では Reserpine_MRM3_609.397.dam を開きます。 

＊ イオンソースの最適化を行った場合は、そのメソッドを開きます。 

2. Acquisition Method で LC sync になっているかを確認します。 

 

3. MS3 の Experiment を右クリックし、Copy this experiment で Experiment を追加し

ます。 
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4. Experiment2、3 に、MRM3 Optimization で Intensity が高かった MS3 の 2nd 

Precursor Ion と AF2 を含む Compound タブのパラメータを入力します。 

 

  

 

例）609/397/236 の場合 

2nd Precursor: 397.16 

CE: 37 

AF2: 0.1 

例）609/174/236 の場合 

2nd Precursor: 174 

CE: 47 

AF2: 0.075 

例）609/195/173 の場合 

2nd Precursor: 195 

CE: 45 

AF2: 0.1 

195 

174 
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5. 各 Experiment の Scan rate を設定します。 

＊ Scan rate は、1000、10000、20000Da/s を選択できます。 

＊ Training では、10000Da/s を選択します。 

6. Number of scans sum に Experiment の積算回数を入力します。 

＊ Experiment の数にもよりますが、Cycle time1 がピークの 1/10 程度の時間になることを

目安に設定します。 

＊ 一度 Advanced MS のタブへ移動し、イオンを溜める時間（Fixed LIT fill time と Dynamic 

fill time）を切り替えた後に MS タブへ移ると、Number of scans to sum 欄の数字が「1」

に戻ります 

＊ Training では、「2」程度を入力します。 

7. FIA でイオン源の最適化を行っていない場合は、Source/Gas のタブを開き、イオン

ソースの各パラメータを入力します。 

8. 各 Experiment の Advanced MS のタブを開き、Dynamic fill time に 

9. チェックを入れます。 

10. Resolution Q1 を選択します。 

＊ MS/MS/MS は非常に選択性の高いスキャンですので、Q1 の Resolution を Low にすると

で、S/N が良好になる可能性があります。 

＊ Training では、Low を選択します。 

 

11. File＞Save as でファイルを保存します。 

＊ Training では、Reserpine_MRM3.dam と保存します。 

⑦ 

⑦ 

⑧ 
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3.5.2 HPLC の条件設定 
1. Acquisition Method の上を右クリックし、Add/Remove Device Method 画面に 

てチェックを入れ、HPLC が使用可能な状態にします。 

 

2. Shimadzu LC System のアイコンが出てきますので、をクリックします。 

3. Pump のグラジェントや流速の条件を設定します。 

 

4. Autosampler のクーラーやリンスモードなどの条件を設定します。 
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5. Oven の条件を設定します。 

 

6. Time Program の条件を設定します。 

 

7. 注入量の設定を行います。 

 

8. HPLC 条件を追加したメソッドを上書きする場合は、そのまま Save し、 

名称を変える場合は、File>Save as を選択し保存します。 

＊ Training では、Reserpine_MRM3.dam と上書き保存します。 
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3.5.3 MS3 の Max Fill Time の Default 値の変更 

 

1. Acquireモードにカーソルを合わせ、メニューバーのTools→Settings→Method Option

を開きます。 

2. EPI/MS2 Scan の Max Fill Time を Default 250 から 100 へ変更することを推奨しま

す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 System の平衡化、Batch の作成、測定の開始につきまして、「初級定量トレーニング

テキスト」をご参照ください。 
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3.5.4 MRM3 メソッド作成 

 

1. メニューの File>Open から画面を開き、File type を Acquisition Method とし、 

43 ページで保存した Acquisition Method「Reserpine_MRM3_609.397.dam」又は、 

49 ページで保存した「Reserpine_MRM3.dam」を開きます。 

＊ Training では Reserpine_MRM3_609.397.dam を開きます。 

2. Acquisition Method で LC sync になっているかを確認します。 

 

3. Mass Spec をクリックし、Scan Type が MS/MS/MS(MS3)であることを確認します。 

 

 

 

 

 

 

 

4. Scan rate を設定します。 

＊ Training では、1000 Da/sec を選択します 

5. Polarity が Positive であることを確認します。 
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6. Number of scans to sum に数値を入れます。 

＊ 取得できるデータポイント数が 10 以上になる、できるだけ多い数字を入れます。 

＊ Number of scan to sum の表示について、一度 Advanced MS のタブへ移動し、イオンを溜める

時間（Fixed LIT fill time と Dynamic fill time）を切り替えた後に MS タブへ移りますと、

Number of scans to sum 欄の数字が「1」に戻ります。 

＊ Training では、Number of scans to sum「3」程度を入力します。 

7. 測定化合物の 1st Precursor、2nd Precursor を確認します。 

8. Center/Width にチェックを入れ、Center にご使用のマトリックスに有効な 2nd 

product Ion を入力、確認します。 

9. Width を入力します。 

＊ Width の幅をあまり狭くすると、感度が悪くなることがあります。 

＊ Training では、Center=236.0(Da)、width=25(Da)と入力します。 

10. Optimize Masses を押しますと、自動で Time(Scan Time)が計算されます。 

11. Edit Parameters…を開き、Compound のタブのパラメータを確認します。 

 

＊ Scan rate、見たい m/z の範囲、イオンを溜める時間、Number of scans to sum で

積算する回数を総合的に考慮します。 

＊ 目安は、Cycle time がピーク幅の 1/10 程度の時間になるようにします。 

定量性を確保するために、最低 10 ポント以上のデータポントを取得することを推

奨します 
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3.6 Explore モードでのデータ確認方法 
作成した MRM3 メソッドで測定したデータの閲覧方法及び定量解析時のピークの幅

を決定します。 

 

1. Explore モードから MRM3 のデータを開きます。 

2. TIC の X 軸にある緑矢印をダブルクリックします。 

下図の場合は、2 つの Experiment で MRM3 を組んで測定したデータです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Experiment1 の MRM3 データに絞って説明します。 

MRM3 の TIC に検出されているピークをカバーするようにマウスでドラッグします。 

 

Experiment1 の MRM3 の TIC 

Experiment2 の MRM3 の TIC 
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4. ドラッグした帯をダブルクリックし、スペクトルを抽出します。 

5. スペクトルの幅は、235.8 – 236.8 Da とわかります。この値をクロマトグラを作成す

る時の幅を決める参考にします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

拡大 
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3.7 MS/MS/MS の定量解析 
MS/MS/MS の定量解析には、「Build Quantitation Method を用いる方法」と「Quantitation 

Wizard を用いる方法」があります。 

3.7.1 Build Quantitation Method を用いる方法 
1. Quantitation Method をダブルクリックします。 

Select Sample の画面が表示されます。 

ここでは、MS3 で測定した解析メソッド

を作成したいサンプルを 1 本選択し、OK

を押します。 

 

 

2. Create Quantitation Method – Define Peaks For MassSpec 画面が表示されます。 

ここでは、定量計算したい化合物の MS3 の 2nd Product Ion(m/z)を入力します。Name

欄には適当な名前（化合物名等）を入力します。 

＊ Analytes の Internal Standard 欄は何も設定しません。 

Next をクリックして、次の画面に進みます。 

 

3. Data Source のプルダウンより、Period1 / Expt2 を選択します。 

ここでは、内部標準物質化合物の MS3 の 2nd Product Ion(m/z)を入力します。 

Name 欄には適当な名前（内部標準物質名等）を入力します。 

＊ Analytes の欄は何も設定しません。 
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Next をクリックして、次の画面に進みます。 

 

4. 内部標準の 2nd Product Ion を入力した後、Data Source のプルダウンより、Period1 / 

Experiment1 のタブへ戻ります。Analytes の Internal Standard 欄をプルダウンから

選択します。 

 

 

 

5. Integration のタブへ進み、ピークやバックグラウンドの指定、スムージングの指定な

どを行って下さい。複数 Analyte がある場合は、Analyte をプルダウンで切り替えて

下さい。 
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6. Calibration のタブへ進み、検量線の Fit 及び重み付けを設定して下さい。 

＊ Apply to all analytes にチェックを入れなければ、analyte ごとに検量線の Fit 及び重み付けを

設定できます。 

 

7. File ＞Save as で名前を付けて保存します。 

＊ Training では、Training と名前を付けます。 

8. Create Quantitation Set で、Quantitation Wizard をダブルクリックします。 

Create Quantitation Set – Select Sample 画面が表示されます。 

9. ここでは定量するサンプルを選択します。 

定量計算に用いる*.wiff ファイルを Available Data Files:欄から選択した後、 

該当のサンプルを Available Samples:欄から選択し、右矢印をクリックして 

Selected Samples:欄に移行させます。 

この時、他のファイルのデータも同時に処理できますので、同じくファイルを選択

した後にサンプルを右に移します。.MRM_MS3:STD_0.001ppb 

定量したいデータを全て選択したら、Next をクリックし、次の画面に進みます。 
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10. Create Quantitation Set – Select Settings＆Query 画面が表示されます。 

Settings to Use:では、出力される Table Settings の設定を選択できます。 

プルダウンより選択したら Next をクリックし、次の画面に進みます。 

＊ 初期設定の場合は Default のみが存在します。 

＊ 下部は QC サンプルなどが基準に入っているかどうかの条件を入力する場所です。 

条件を設定する必要がない場合、None を選択します。 

 

11. Create Quantitation Set – Select Method 画面が表示されます。 

ここでは定量に用いる解析 Method（*.qmf ファイル）について設定を行います。 

7 で名前を付けた解析メソッドを選択して Finish をクリックして下さい。

 

12. Result Table が作成されます。 

「Sample Type」をプルダウンから、Blank、Standard、Unknown 等適切なタイプを

選択して下さい。 
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13. Result Table の「Analyte Concentration」に、検量線の各濃度を入力して下さい。 

 

 

 

 

14. Result Table の「IS Concentration」に、内部標準物質の濃度を入力して下さい。 

 

 

 

 

 Table Settings の設定方法は、「中級定量トレーニングテキスト」の「Results Table の編

集と解析」を参照下さい。 

 

3.7.2 Quantitation Wizard を用いる方法 
1. Quantitation Wizard をダブルクリックします。 

Create Quantitation Set – Select Sample 画面が表示されます。 

2. 定量計算に用いる*.wiff ファイルを Available Data Files:欄から選択した後、 

該当のサンプルを Available Samples:欄から選択し、右矢印をクリックして 

Selected Samples:欄に移行させます。 

この時、他のファイルのデータも同時に処理できますので、同じくファイルを選択し

た後にサンプルを右に移します。.MRM_MS3:STD_0.001ppb 

定量したいデータを全て選択したら、Next をクリックし、次の画面に進みます。 
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3. Create Quantitation Set – Select Settings＆Query 画面が表示されます。 

Settings to Use:では、出力される Table Settings の設定を選択できます。 

プルダウンより選択したら Next をクリックし、次の画面に進みます。 

＊ 初期設定の場合は Default のみが存在します。 

＊ 下部は QC サンプルなどが基準に入っているかどうかの条件を入力する場所です。 

条件を設定する必要がない場合、None を選択します。 

4. Create Quantitation Set – Select Method 画面が表示されます 

ここでは定量に用いる解析 Method（*.qmf ファイル）について設定を行います。 

新規の解析 Method を作成するため、Create New Method の Method Name: 

に新規 Method 名を入力し、Next をクリックして次の画面に進みます。 

＊ 既存の解析 Method を使用する場合（Batch 作成時に解析 Method を作成した場合等）は、

Choose Existing Method を選択し、Method:のプルダウンより解析 Method を選択します。

Finish をクリックすると、Result Table が作成されます。 

 

5. Create Quantitation Method – Select Representative Sample 画面が表示されます。 

ここでは解析 Method を作成するための基準となる Sample を選択します。 

ノイズとシグナルを適正に判別するため、できるだけ検出下限値付近の 

Sample を選択します。選択後、Next をクリックして次の画面に進みます。 
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6. Create Quantitation Method – Define Peaks For MassSpec 画面が表示されます。こ

こでは、定量計算したい化合物の MS3 の 2nd product ion(m/z)を入力します。 

 Name 欄には適当な名前（化合物名等）を入力します。 

＊ Analytes の Internal Standard 欄は何も設定しません。 

 Default Smoothing Width:では、クロマトグラムのスムージングを設定すること

ができます。必要に応じて適当なスムージングポイントをプルダウンから選択し

て下さい。 

Next をクリックして、次の画面に進みます。 

 

7. Create Quantitation Method – Define Peaks For MassSpec 画面が表示されます。こ

こでは、定量計算したい内部標準物質化合物の MS3 の 2nd Product Ion(m/z)を入力し

ます。 

 Name 欄には適当な名前（内部標準物質名等）を入力します。 

＊ Analytes の欄は何も設定しません。 

 Default Smoothing Width:では、クロマトグラムのスムージングを設定すること

ができます。必要に応じて適当なスムージングポイントをプルダウンから選択し

て下さい。 

Next をクリックして、次の画面に進みます。 
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8. 下記のようなメッセージが表示されますが、Yes をクリックして、次の画面に進みます。 

 

 

9. Create Quantitation Method – Define Integration 画面が表示されます。 

ここでは定量計算したい化合物や内部標準物質におけるピークの積分条件の定義を行

います。 

Internal Standards、Analytes の順に画面上に表示され、各々の定義を行います。 

バックグランドの範囲指定：表示されているクロマトグラフ上で、バックグラウンド

に指定したい範囲をドラッグし、 アイコンをクリックすると、選択した範囲の

ノイズがバックグラウンドとして設定されます。 

ピークの範囲指定：表示されているクロマトグラフ上で、ピークに指定したい範囲を

ドラッグし、 アイコンをクリックすると、そのピークの Retention Time が設

定され、Ret Time:に Retention Time が表示されます。 

 

 

 

 

 

 

 

その他のパラメーターの設定 

Advanced をクリックしますと Advanced 画面が表示され、 

Filtering Parameters（ピークの積分に必要な 

最小のピーク高さや幅の設定）や Smoothing Width、 

Concentration Units（濃度単位の設定）等を設定 

することができます。 

設定後、Next をクリックして次の画面に進みます。 



 

 63

＊ Filtering Parameters の推奨値は、 

Minimum Peak Height : 10 cps 

Minimum Peak Width : 3 secs 

10. Create Quantitation Method – Specify Calibration 画面が表示されます。 

ここでは検量線に用いるパラメータの設定を行います。 

 Fit:では、検量線のタイプが設定でき、プルダウンより選択することができます。 

 Weighting:では、検量線の重み付けが設定でき、プルダウンより選択することが

できます。 

 Regression Parameter では、作成される検量線のデータの種類を、Area（ピーク

面積）あるいは Height（ピーク高さ）から選択します。 

 

11. 設定した後、Finish をクリックすると Result Table が作成、表示されます。 

12. Tools＞Result Table＞Modify Methods…より、Edit Quantitation Method を開きま

す。 
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13. Edit Quantitation Method の Components タブを開きます。 

Analytes の Internal Standard 欄で、プルダウンより内部標準物質の名前を選択して

下さい。 

 

14. OK をクリックして、Result Table の画面に戻ります。 

Modify Method を行った後、Tools>Results Table>Export Method を選択し 

ます。 

 

ここで Quantitation Method を上書き保存、もしくは別名で保存して下さい。 

＊ Modify Method は編集するのみで、保存は行われません。 

 

 

 

 

 

15. Result Table が作成されます。 

「Sample Type」をプルダウンから、Blank、Standard、Unknown 等適切なタイプを

選択して下さい。 
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16. Result Table の「Analyte Concentration」に、検量線の各濃度を入力して下さい。 

 

 

 

 

17. Result Table の「IS Concentration」に、内部標準物質の濃度を入力して下さい。 

 

 

 

 

 その他 Table Settings の設定方法は、「中級定量トレーニングテキスト」の「Results Table の編集と

解析」を参照下さい。 
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4 参考資料 
 

4.1 参考資料１ トラップ機能の ER 測定と EPI 測定 
 

 

 

 

 

 

 

 

 

1. Q1 でイオンが選別されます。 (Open resolution, 5-7 Da) 

2. 選別されたイオンはフラグメンテーションを起こすことなく q2 を通過します。 

3. q2 を通過したイオンは、 LIT(Q3)にためられます。 

4. LIT(Q3)にためられたイオンは、ゆっくりスキャン(250 Da/sec)され検出されま 
す。 

       

 

 

 

 

 

 

 

 

1.  Q1 でプレカーサーイオンが選択されます。  

2.  プレカーサーイオンは、q2 (LINAC® Collision Cell) で開裂します。 

3.  q2 (LINAC® Collision Cell) で生成したフラグメントイオンは、LIT(Q3)にため
られます。 

4.  LIT(Q3)にためられたイオンは、スキャンされ検出されます。 

Enhanced Resolution (ER)

Q0 Q1 q2 Q3/LIT

Resolving No 
Fragmentation

Trap & ScanQ0 Trapping

Q0 Q1 q2 Q3/LITQ0 Q1 q2 Q3/LIT

Resolving No 
Fragmentation

Trap & ScanQ0 Trapping

Enhanced Product Ion (EPI)

Q0 Q1 q2 Q3/LIT

Resolving Fragmentation Trap & ScanQ0 Trapping

Q0 Q1 q2 Q3/LITQ0 Q1 q2 Q3/LIT

Resolving Fragmentation Trap & ScanQ0 Trapping
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4.2 参考資料２ スキャンスピード 

 

 QTRAP® 4500、QTRAP® 5500 システムでは、MS/MS/MS のスキャンスピードは、1000, 

10000, 20000 Da/sec の３種類が選択できます。 

スキャンスピードに応じて、装置がイオンを溜める時間を自動で以下のように決めてい

ます。 

取得するデータポイント数が 10 以上ある場合は、スキャンスピード 1000Da/sec をおす

すめします。 

＊  

＊  

＊  

＊  

＜スキャンスピードを変更した場合の S/N について＞ 

 

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  
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4.3 参考資料 3 スキャン範囲 

 

 MS/MS/MS 測定で Center/Width のチェックを入れると、Center のマスとスキャン範

囲（Width）を手動で入力できます。 

その場合のスキャン範囲は、Width≧10 をおすすめします。 

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  

＊  
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4.4 参考資料 4 データポントの目安について 

 

例1）Experiment1: m/z 609由来のm/z 397.2がフラグメンテーションして得られる ス

ペクトルを、100-400Da のマスレンジでスキャンし Number of scans to sum を「1」に

した場合 

 100-400Da のマスレンジをスキャンするために費やす時間＝0.3001sec 

 Total Scan Time＝0.3001sec + Pause time + トラップ特有のパラメータ時間  

＝0.4550sec 

 Cycle time= Total Scan Time =0.4550sec 

Analyte のピーク幅が 10sec だとすると、約 20 ポイントのデータポイントが

取得できます。 

 

 

例 2）Experiment1: m/z 609 由来の m/z 397.2 がフラグメンテーションして得られるス

ペクトルを、100-400Da のマスレンジでスキャンし、Number of scans to sum を「2」

にした場合 

 100-400Da のマスレンジをスキャンするために費やす時間＝0.3001sec 

 Number of scans to sum＝2 

 Total Scan Time＝(0.3001sec + Pause time + トラップ特有のパラメータ時間)x2

＝0.4550sec x 2＝0.9099 

 Cycle time= Total Scan Time ＝0.9099 

Analyte のピーク幅が 10sec だとすると、約 10 ポイントのデータポイントが

取得できます。 
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例 3）Experiment1 は（例 1）とし、Experiment2 : m/z 654.2 由来の m/z 346.0 がフラ

グメンテーションして得られるスペクトルを、100-400Da のマスレンジでスキャンし、

Number of scans to sum を「1」にした場合 

 100-400Da のマスレンジをスキャンするために費やす時間＝0.3001sec 

 Total Scan Time＝0.3001sec + Pause time + トラップ特有のパラメータ時間 

＝0.4550sec 

 Cycle time＝Experiment1 Total Scan Time +  Experiment2 Total Scan Time  

＝0.4550sec + 0.4550sec＝0.9099 

Analyte のピーク幅が 10sec だとすると、約 10 ポイントのデータポイントが

取得できます。 

＊  

＊  

＊  

＊  

＊  
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例 4）Experiment1 は（例 1）とし、Experiment2 : m/z 654.2 由来の m/z 346.0 がフラ

グメンテーションして得られるスペクトルを、100-400Da のマスレンジでスキャンし、

Number of scans to sum を「2」にした場合 

 100-400Da のマスレンジをスキャンするために費やす時間＝0.3001sec 

 Total Scan Time＝(0.3001sec + Pause time + トラップ特有のパラメータ時

間)x2＝0.4550sec x 2＝0.9099 

 Cycle time＝Experiment1 Total Scan Time +  Experiment2 Total Scan Time＝

0.4550sec + 0.9099sec＝1.365sec 

Analyte のピーク幅が 10sec だとすると、約 7 ポイントのデータポイントが取

得できます。 

＊  

＊  

＊  

＊  

＊  

＊  
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4.5 参考資料 5 LIT にイオンを溜める方法 

 

 

Q3(Liner Ion trap)にイオンを溜める方法は、2 通りあります。 

① Fixed LIT fill time 

イオンを溜める時間を任意に指定する溜め方です。 

＊ 通常 Q0 Trapping を使用する場合が多いです。 

② Dynamic fill time(DFT) 

サーベイスキャンのイオン量に応じて溜める時間を自動計算させる方法です。      

＊ 溜める時間の最適値がわからない場合には、Dynamic fill time を使用します。 

＊ Q0 Trapping は使用できません。 
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4.6 参考資料 6 Q0 Trapping 機能 

 

 

 

 

 

 

 

 

 

 

 

 

Q0 Trapping 機能とは？ 

LIT 特有の機能であり、イオンが LIT 内から検出器に吐き出されている間、次に入っ

てくるイオンを Q0 部分でためることができる機能です。 

 

主に EPI や MS/MS/MS にて使用します。 

イオントラップ内に溜めたイオンを検出器へ吐き出している間、イオントラップの入

り口は閉じられた状態となり、流れてくるイオンはイオントラップに入ることなく、

捨てられてしまいます。 

 

Q0 Trapping 機能は、イオントラップの入り口が開放され、イオンが導入可能となる

まで、Q0 のところでイオンを溜めておく機能です。 

Q0 で溜めておいたイオンが一気に Q3 へと流れてくるため、更なる感度上昇が可能で

す。 

  

Q3/LIT

EXIQ3

Q0

IQ1

Q0

IQ1
●トラップにイオンをためている間、イオンは、全ての四重極を通過します。

Q0

IQ1

Q0

IQ1

Q3/LIT

EXIQ3

Q3/LIT

EXIQ3

●イオンのトラップが終了後、IQ1 にバリアを張り、イオンをQ0でトラップします。

Q0

IQ1

Q0

IQ1

Q3/LIT

EXIQ3
●トラップにためられたイオンがスキャンされるまで、イオンは、Q0でトラップ
されます。スキャン終了後 IQ1及びIQ3のバリアが解除され、再びイオンは全ての
四重極を通過します。

Q0 Trapping機能（2）



 

 74

 

----------------------------------------------------------------------------------------------------------------------- 

研究用にのみ使用できます。診断目的およびその手続き上での使用は出来ません。 

 

For Research Use Only.  Not for use in diagnostic procedures. 

The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their 
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AB SCIEX™ is being used under license. 
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